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1. BIS

|

RICATRAME Ry ST-SCL 2B 5 AT S H okl A B @I i AT B 52, Aety s 4f
o2 >) ST-SCL St 5 o VUIJ 3L T ST-SCL gafe B S IR TF M, E2eke ST-SCL -5,
T Al Windows 328 JF4f—>Simatic—>Documentation—>English A LAis: 3 44 K 4“S7-SCL for
S7-300 and S7-400” [ PDF F-M. UbFM3Lo0 16 A& Ay, HiEdihiiig 7 S7-SCL gwfe s 5
— V15T ST-SCL A I #y 1) i DAL T3 DAy v

FIXS TP 1 )T PLC B H B G AE =, ST-SCL 5 ST ML i e Pl 35 A5 45 I AT (R ok,
HEAF ] Hefphid PASCAL 8% VB 4 il 5, SEIL ST-SCL PRI T2 AR R A S o Jr LAASCH
AR ST-SCL ATHMTFM—FEMTEAN PEIR, T 5128 — AN sl 7, AFEes Sl S7-SCL
POENT T PRI NG, FRAUES S P e SE R 2 T 22 B B 1) . X5y
WHERZ K HERRH ), RABSRIOESHE, fHE Rt 1A .

FHOGT b b3 B2 -
S7-300 Al S7-400 [WHEfJ#K (STL) 2wt

http://support.automation.siemens.com/CN/view/zh/18653496

{fiH] STEP 7 V5.3 %ifs

http://support.automation.siemens.com/CN/view/zh/18652056

S7-SCL V5.3 for S7-300/400

http://support.automation.siemens.com/CN/view/zh/5581793

2. WAFHIEAEFR

2.1. S7-SCL f&ifr
S7-SCL (Structured Control Language #5#Jfkiz#liE=) EBG U TN A:
<> BB T PASCAL I R MR
> O EBRFRHEIEC 61131-3
< PLCopenZ&hh ik
< IEHT SIMATIC S7-300 (HE##HITCPU314LL [-CPU), S7-400, C7 and WinAC
ST-SCL 4 PLC fi T AL AL B, AU HAT PLC MUALIICE (Bl N / v, eI,
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2.2. ST-SCL 5 STL:

ST-SCL HJ LA B STL, SR HARTGEAHAS T STL S Frsn, [H3RATSE 00 R PR 4
FIRIFRFF AR . ROLT IR, CG0TE 5 C8ma e, MM [ C/CH55
PR o ST-SCL M TR Bt A BRI, i B — 5 FTE ML 0T 35 A R g R 15
2.3. ST-SCL W35 -

STEPT Hr#ERRIFANELAS ST-SCL ARAF0 JAZAL, 75 Sy %, STEPT Professional AT T
ST-SCL WAL SRR, 3R] . fF ST FEJprh, S7-SCL Benf LA STEPT 4afeih & AL kit
YU AR o ST-SCL Az s iy ety nT LAVE S PRSP e i 5 5 I o H T S7-SCL #2531 ASCIT SCA
G T E AR AT NS H .

2.4. ST-SCL ¥k FH 21
ANTA] ST-SCL #AF R A L) STEPT M HAFE R G2 MR B R X BRI, - R AHEE

STEP 7 V5.3 STEP 7 V5.4
Version | Order Number Win Win XP | Win XP Win Win XP | Win XP Win Win
2000 5P1 SP2 2000 5P1 SP2 2003 2003
SP4 5P4 5P1
V53 | 6EST 811-1CC05-0YAS X i X X X X 33 33
V5.l |6E3T81L-1CC04-0vHD | XU X3 X X0 X X7 - -
1) AAX S7T-SCL V5. 1+SP1 8y LA A S 4
2) VAL S7T-SCL V5. 1+SP1 8% UL i A 3
3) AXAN S7-SCL V5. 1+SP1 88 LA A S
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3. S7-SCL NHTF Bl T#E

3.1 U TRTZEK
TN TR LA R DL R Y FH R 2845133 W] ST-SCL FRIAEEH]
R TR T ZESHIA LR
S RN R, BT TREERH, AT AR IER, TR0 R LR K
Lot /MEZ G B EE . LR fzE4)D
> RIS HAE, AT, RIS (BRI, A 4D
3.2. S7-SCL faj B or 4
TENMMEIFHA, 'S —A5EBARFIERFLT 4 FBL, PR — FBL, JURE—ANHIM
WA, fFfAE FIFO HERRH, 3L 10 DMABIRCRIE, i 10 NIRRT
KU 10 AREEE T A K ME R, IFVHSC R B L d KB S IME 5 P34
SFRME QEE D = (10 SR E AT K-/ MED /8
SPRME RSB =55 S RAHE
1) #rdtmiH, #fiA SCL Source

HSIMHTIE Manager - [tools_example -- D2\ Siemens’,Step? - |EI|£|
% File Edit Insert PLZ Wiew Options ‘Window Help _|5’|£|
D |89 4 2@ dalle %5 %) i 2 | & |[<NoFiler

% tools_example
=l SIMATIC 400(1)
=-[@ cPU 41220P
[E-{z7] 57 Program(1]

gy Bl Chrl+
Copy Chrl4+C
Paste Chrl+y
Delete Del

Insert Mew Object STL Source
PLC SCL Source

SCL Compile Conkrol File
Rehame . Fz GRAPH source
Obiject Properties. ., Alk+Return
Special Object Properties 3 External Source. ..
Inserts SICL Source ak the COFSEF posito. e

P4 3-1: #r&t SCL Source

2) Xi, SCL Source fJJFF SCL ¥%%, JHEH] FB B
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] 5 ) 5
E%SEL - [5CL Source{1) -- tools_example'\SIMATIC 400{1}"CP

File Edit | Insert PLC Debug Wiew Options Window Help

=10l x|
=& x|

heza | |
O

FE
FC

Dlﬁ'l El Black Call...
S
i=| @ o€ 8|5 12|51 |nf

4% %] %

Block Template

Control Struckure  #

Comment
Conskant

Patarneker

DB

Instance DE

DB Referencing UDT
ot

&

[ 4] = [l Emor p Info

Inserts texk layout for a new Function block at the cursor position, |
3-2: ffiH] FB BiAR
3) WK FB %'y

EﬁSEL - [SCL Source(1) -- tools_example’, SIMATIC 400{1 )\ CPU 412
File Edit Insert PLC Debug Wiew Options ‘Window Help

ln 1 Cal 1

=101 |
=18 %]

D& & v ]2
eea|salaz] 50| <0l [T 22| w2
i=] @ [pe] o] 125 b |

%% %l |

FURCTION_BLOCE FExxx

YAR_TENP
/¢ Temporary Variables

TH) FB %
5, . FB1

ERD_VAR
VAR

£f Static Tariables
END_VAR

/¢ Instruction Section

END_FURCTION_BLOCE

i

|»

o

|4 A e Error g, Info

Press F1 For help. [
3-3: BB %is
4) AEHIZSHIAR

Lm 14 Cal 4

s v
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Eﬁ SCL - [SCL Source(1) -- tools_example' SIMATIC 4001 )L, CPU 412-2 [ - |I:I|i|

File Edit | Insert PLC Debug Wiew Options Window Help _|E|i|

0ez Black Call.. l= | eolenlsl sl ar| ] [T =E(m| w2l

E EBlock Template r 0B | | I_%l |m| k

EE' @ |§q| Contral Struckure * - FB
FC

478 5%] %]
Comrment
Caonskank ;I

FURCTION_BLOCE FEl

Parameter

YAR_TENP LE
Instance DB

DB Referencing UDT
ERD_¥AR LoT
VAR
A Static Variables

A Temporary Variables

ERD_VAR
£ Instruction Section

END_FUNCTION_BLOCE

4 o

[ A LY Eror b Info

Inserts bext lavaut For a parameter section at the cursor position, | |tn 3ol 1 NS |MOD

3—4: VSN FB #y N =5
5) %’ FB %

D@ & of | =]
FUORCTION_BLOCE FE1
/" Block Parameters
¥AE_TRFPUOT

Ff Input Parameters
ERD_VAR

YAR TN OUT
S I Paramete
|EHD_TBR
YAE_OUTPUT
£5 Output Parameters
END_VAR

GniEmIN,
i, I, G

YAE_TENP
Ff Temporary Variables

END_VAE

YAR
£f Static Variables

END_VAR i
S Instruction Section
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Kl 3-5: #I0 FB N 250

6) U HIE ] Zh gk ) 3

HRSCL - [SCL Source(1) -- tools_example',SIMATIC 400(1),CPU O] x|
File  Edit | Inserk PLC Debug “iew Options ‘Window Help - |ﬁ‘|£|
0 | Er:l E | Block Call... E
Block Template r
E"l’c'ulE’E«lﬁl Contral Struckure  » %lglml El
i=| @ |34 e]eo] 2] |bm|
4% 5% %]
ERD_¥AR =]
YAR
£ Static Variables
ERD_YAER

Ff Instruction Section

END_FURCTION_BLOCE

=l

i

[ A Qe Enor  Info

Inserts bext layout for a block call at the cursor position. | |Ln 23 Cal 1 NS 3
K 3-6: AT A Dhredern) 3
7) A FC105
Insert Block Call x|
Entry point: Wi
ILiI:urar_l,l j IE:::mpu:unent wiE j ) rline & Offline
Mame: Storage path:
IStandard Libirary j ID:'\Siemens'\Step?'\S?Iibs'\stdlibSD Browse. . | | e
-- Organization Blocks ;I Object name | Symbolic name | Created in Ianguac:l
FID Caontrol Blocks &3 FC103 coT STL
Z3 FC104 TEL_TEL 5TL
Z3 FC10E UMSCALE 5TL
KN — _>I:I
Object name: |FE'I 05
Object type: I.-'fl.ll j
Cancel Help |

K 3-7: i FC105
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8) i T7E SCL i T FC105, iRF54F SIMATIC Manager ¥ FC105 ¥ hnz|mi H

Open Project X|

User projects  Libraries | Sample pru:uieu:tsl Multipru:uieu:tsl

M arne | Storage path il
@ FROFIMNET Sestem-Library  D:ASiemens\Step? S7libsh\PROFINET
@ Redundant 10 1] D:4SiemenzhStepS Flibshred_io_0
@ Redundant [0 CGP D:hSiemenzhStepS Flibshred_io_1
@ SIMATIC_MET_CF D:4SiemenzhStepd S Flibshzimaticn

. Standard Library . ] shatdlib30
@ stdlibs 2] [D:4SiemenzhStepd S Flibshatdlibe
@ Sw'R_LIB_ W12 [:ASiemenzhStep 7S Flibshewr_lib

4| | »

¥ 3-8: SIMATIC Manager "7 F% 1t
9) FC105 & HIZ 2wy H -

ol
File Edit Insert PLC \Wiew Options indow Help
DS (2 | % B |dnl[o 25 2| i 2 | & || <NoFiter> R
'Ei?;tunls_euample -- Dy Siemens', Step 7' s7projttools_ex - |EI|5|
=28 tools_example 5 Suztem data
E-E SIMATIC 40001
e[l CPU 412-2DP
=--=3 57 Program(1]
(B Sources
-} Blocks
Iiff;,'-fistandard Library -- D Siemens' Step 7' 57libs, stdl - |I:I|1|
=42 Standard Library FB&0 &3 FET &3 FRa2
#-{z7] Communication Blocks FBE3 &3 FES4 &3 FBA5
IEC Function Blockz FBAE &3 Frao &3 FCE
Mizcellaneous Blacks FCa? &3 Fraa & FCad
[#-{z7 Organization Blocks FLas &3 FCe6 &3 FCE7
[H-{z] PID Contral Blocks FCas &3 FC83 &3 FC90
5h-57 EDH\I’E[“HQ Blocks FCo p FCg2 g- FC9a
.. Suztem Functipn Blocks g4 &5 FLI5 &3 FL96
El-- %SB?IEo:vemng Blocks FCq7 3 FC98 &3 FC3
""" — FC100 &3 Fi0n &3 Fri0z
FC103 &3 FCiod &3 FC105
FC106
Insert Funckion': was executed successfully For 1 of 1 objects. | [TCPYIP - = Broadcom Metitreme 57x... | 2

3-9: ¥ FC105 & I3 2147535 H
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10) FB1 %5 X

E_ﬁSEL - [SCL Source(1) -- tools_example\SIMATIC 400(1)CPL 412 - |EI|£|
File Edit Insert PLC DCebug View Options ‘Window Help == x|

0|2|B| S| oo 5[] eules|sald] | <21 [T &IS|mM| K2
i=| o |#6| @8]0 12| |bm|

47| %] %

FURCTIOR_BLOCK FE1 -
YAR_INPUI £ATE N R

PIV_IN: INT;

HI_LIM_IN: RELL :=100.0;

Lo LIM_IN: RE4L :=0.0;

BIPOLAR_IN: BOOL :=FALSE;
ERD_VAR

VAR IR _OUT
END_VAR

VAR_OUTPUT AOTE S i
SCALED VAL: RELL; i
SCALED FILTED: REAL;
ERR: BOOL:

ERD_VAR

YAR_TENP SOE G Bt E
RET_VAL_105: WORD ;
LOOP_COUNT: INT;
MAY DATA: REAL ;
MIN_DATA: REAL ;
TOTAL: EEAL ;
TOTAL_FILTERD: REALL:
ERD_VAR

VAR SIENTEETE
DATA_STORE: ARRAY([0..2] OF REAL:
ERD_VAR

K 3-10: FB1 3% X
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11) FC105 i /1]

E_ﬁSEL - [SCL Source{1) -- tools_example’SIMATIC 400{1)"CPU 412-2 DP - | I:Ilﬂ
File Edit Inmsert PLC Debug Yiew Options ‘Window Help —|=] x|

D] @] || & [E=]] enles|dala:| ] <Pl [ =|S|m| w2
i=| o |7¢| &5 2|3 |Bm|

4% % 7%

VAR RN BETE B
DATA_STORE: ARRAY[0..3] OF REAL;
ERD_¥AR
A/ R RFCI08
RET_ VAL 105:=5CALE(IN :=PIW_IN i BEIERAE
LHI_LIM := HI_LIM_IN A LfEE LIRE
,L0_LIN := LO_LIM_IN A LFEETIRE
,BIPOLAR := BIPOLAR_IN A TR S
,0UT := SCALED VAL A LEEE
1
A g [E1E

IF RET_VAL_105<> 0 THEN EER:=TEIE;
ELSE ERR:=FALSE;

END_IF;
4| | 3
[ 4 [ » [*IT Eror 2 info f
Press F1 for help. | lLr 40 Col & M5 Moo s

K 3-11: FC105
12) NIRRT AW AR, AESAEH TF AR

ol 5
HHSCL - [SCL Source(1) -- example_scl',57 Program{1)}] O] x|
File Edit | Insert PLC Debug Miew Options ‘Window Help =151 x|
Block Call. ..
0|z =] 2]
Block Template 3 : :
E"l’c'lle'?:rlﬁl Control Struckure  ® I k?l
—_—
CASE
II= *
i=| @ 24| 8] e[ 12| [ ‘ FOR
WHILE F
Translate: example =clh27 Pr roesW3CL Source(l) ,;I
: SCL Sourceil) REPEAT r =
|4i4i lilli&fﬂﬂrﬂ Irif ;
Inserts texk layout For an IF skatement ak the cursor position, | ILn 10 Cal 3 I

Kl 3-12: ffH] IF #ifk
13) f# /] IF, FOR-NEXT %%&gif = My, IRAE L nl %S HIg iy
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EHSCL - [SCL Source(1) -- tools_example!, SIMATIC 400(1)',CPU 412-2 DP] =10l =]
File Edit Insert PLC Debug ‘iew Options ‘Wwindow Help ;Iilil
D[] @ oo % [E(e] enles|sald] | 1< [T &IS|M| w2
] I a2 ed R
45 %| %]
Mi¥ DATA:=DATA STORE[0]; ARk [
MIN _DATA:=DATA STORE[O] ;
TOTAL:=0.0;

TOTAL_FILTERD:=0.0;

FOR LOOFP_COTNT:= 0 TO & BY 1 DO Jf FIFO MEde
DATA STORE [LOOP_COUNT] :=DATA_ STORE [LOOF_COUNT+1];
END_FOR:
DATA_STORE [9] :=SCALED_VAL; A InAET R B

FOR LOOP_COUNT:= 0 TO 9 BY | DO
AEHRAE

IF Mi¥_DATA < DATA_ STORE [LOOF_COUNT] THEN MAY _DATA:=DATA_STORE [LOOP_COUNT]

END_IF:
HEHERE

IF NIN_DATL > DATA STORE [LOOF_COUNT] THEN MIN DATA:=DATA STORE [LOOP_COUNT]

END_IF:
FATE R
TOTAL:=TOTAL+DATA_STORE [LOOF_COUNT] ;
END_FOR:
SO E B fE 0
TOTAL_FILTERD:=TOTAL- MIN_DATA- MAX_DATA:
FAEIE R T E
SCALED FILTED:=TOTAL_FILTERD/. 0;

ERND_FURCTION_BLOCE

7

3-13: G SIEBALF
14) fE3ZH. Option—Customize "k £2E B if 115 &

Create Block —Compiler I E ditar I Fu:urmatl Print I

¥ Create object code

G PEIE T
TR PRE R
IR R

¥ Optimize object codd

[~ Monitar array limit

¥ Create debug info
[~ Set 0K flag

¥ Pemit nested comments

b aximum ztring length: IE4 =

3-14: R A

A&D Service & Support

Page 14-39



Excellence in
Automation & Drives:
Siemens

15) fE32 L4 File—Compile 4 i A 4R f5, #alLAZERL FBL T, 7€ 0B35 HHn LA FBL, F
BUEATH J5 4% 0B35:

< HHZ%0 SCALED_VAL S AR

<& WS SCALED FILTED AJEut 5 i SRRE(

> BBOBSSIIAT WIAT,  WRIEIN R R A A, TR A BCEUER AN ) T LU i 2
ASKAEAE, R T RE R E Ay e KA B /ML, 1T e K Bl /MK B 2, IXFE
FLSEL T BB BOR . RFEER AR, IFUERE TR T45 T2TIOI (], SEI i
(A UCRFEE S DB BN, 1153 — RIS 2 5 PS5

F=[LAD/STL/FBD - [@DB35 -- "CYC_INT5" -- tools_example\SIMATIC 400(1)CPU 412-2 D... |0 X|
iF File Edit Insert PLC Debug ‘iew Options Window Help _|E|i|

s IEIEE RS
e [er | 1< ! MW E2 4k # O [T L 1 [ #2

i’ FLO | STA4 | STANDARD |

0B55 @ “Cyclic Interrupt”

He twork 1 HELAIEE

CALL BB 1, DE1 TN ouT
PIV_IN :=PIWR1Z 2764
HI_LIM_IN 1=1, 000000e+HIO2
Lo_LIM_IN 1 =0, 000000 e+HIO0
BIPOLAE_TIN  :=FALSE
SCALED_Val  :=NDO +a_ 997 e+H000
SCALED_FILTED:=MD4 +a_ 997 e+H000
EERR =100 0

) -
| i '

£_|‘| 4] 4] Fl}lr\ 1:Emor & 2Zlnfo A 3 Crossreferences & & Addessinfo. A 5 Modify
-

Press F1 to get Help. i AROMTTTT [abs 5.2 e

K 3-15: Wi 0B35
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16) W LALE e 0 & Jt i | 4% FB1

[ZLSCL - [SCL Source(1) - tools_example’, SIMATIC 400(1)CPU 412-2 DP DNLINE]I -0l x|
File Edit Insert PLC Debug “iew Options ‘Window Help =] x|

D||e| @ =% [E|e enles|sala] [o | <> [T (E(m@ M|

R T e T T e e T |

RN R R I SR N R RN RN IR PO E ORI TR, | |

lollsl|

EET_VAL_ 105:=5SCALE(IN :=FI‘|'|'_II'I EET_WAL_105 = 18#0000, PIW_IN = 2784
JHI_LIM := HI_LIM_ IN HI_LIM_IN = 1.000000e+002
SLO_LIM := LO_LIM_IN LO_LIM_IN = 0.000000e+000
»BIPOLAR := EBIPOLAR_IN BIPOLAE_IN = FALSE
LOUT := SCALED_VAL SCALED_Wal = 9, 88T710Te+000
)
IF FET_VAL_105<> 0 THEN EEE:=TEIE; REET_WAL_106 = 16#0000, EEE =
ELSE ERR:=FALLZE; ERR = FALSE
ERD_IF;
MAY_DATA:=DATA STORE[0O]; Ma¥ DATA = 9.99T10Te+000, DATA_STORE[0] = 9.89710Te+000
MIN_DATA:=DATA STORE[O]; MIN_DATA = 9.99T710Te+000, DATA_STORE[0] = 9.89710Te+000
TOTAL:=0.10; TOTAL = 0.000000e+000
TOTAL _FILTERD:=0.0; y TOTAL_FILTEED = 0. 000000e+000
- s : ; gkt
FOR LOOP_COUNT:= 0 TO & BY | DO LOOP_COUNT = 0
DATA STORE [LOOP_COUNT] : =DATA STOR DATA STORE[O] = 9.997107e+000, DATA STORE[1] = 2.99710T
ERD_FOR;
DATA STORE[9] :=SCALED_VAL:
<| | g | o

Translate: tools_ewample’\SIMATIC 400(1)N\CPIUT 412-2 DPAS5T Program{l)Sources\5CL Source(l)
Flock: FE1
Fesult: 0 Errors, 0 Warning(s = 1:%

[S PN

3-16: Wi# FB1

R, AR ST-SCL R s BIE R 1, ASCHP BUR HARH i 504 T A4 AR 2
FEth 5 A R, JFAE— 81— & i 48, &T S7-SCL I EARMEH], W& ASCER ALt

R ST-SCL FIIFS

3.2.1. EERR.

> RSO R TR S TR ST TR 2200, sl R ORI M (0 TRE B Rt

Irgike, WEEE VIZRHS TRE SO .

S WU R B, AT )R] DA B S AR SR R e B R A X R

Fe AL Dy REVEBGR A TE I DA, AT XU B 6.
< PETT ARG 11 (R R S S A SR
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Excellence in
Automation & Drives:
Siemens

4. S7-SCL % .13 5

4.1. B EMHRKH B

4.1.1. [ S7-SCL ZHHFLL STEP7 Ht, 5HEESHHALKXER?

IR S7-SCL SRR STEPT B, LILEiB S H {1 A KR ?
f#%%: S7-SCL % Fitl F STEP7 [fjbk: OB,FC,FB,DB,UDT. i ST F2J¥H, ST-SCL Henf by
STEP7 Y ih o5 A M B B F o ST-SCL W] AR 1 STL,  ST-SCL A iRty ) LA Sy 5L
PEILE R 91, T ST-SCL AR ASCIL SCAKIRE, B BME A3 2 S 5 A 11

4.1.2. R WATIRTEHIIT & —A> S7-SCL #&F¢?

o) R AT KR Y I T —AS ST-SCL FEfe?
. TP —A> ST-SCL 2y, MM n R ifife:
o MRIFEMPA, WIFHFIIBARG . W A4 FC st L2k, &7
e
o MITATS (FBJFC %%
o JE XA TALS M A N i R
o EANTARSAEIESCAE P S O &
o EXNFFTR
o YmiFRtx
o IR

OB, FB %

4.1.3. \I@: Wil nas3k e S7-SCL 27?2

)R ey in s J i S7-SCL F 7 ?

fit % : ST-SCL R In#Y STL FEF M%7 ik JLF—#F, I/ o] LAAERR 7 opoin N DG k7
KNOW_HOW_PROTECT, FiArgmieRinr, FEHH) FCL fadmit)a, BIHIL TSRy I Ebs .
VERG: SRS 2 (R PN S R S7-SCL JRARAS, 75 I ARG A RS (il R
T FCL), MARTTLLRERATIT S7-SCL AR .
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Excellence in
Automation & Drives:
Siemens

Dbject name | Symbolic name | Created in language | Size in the w
L 081 35 H HLEE

ik OER0 22 ) FCL SCL

L3 FC R SCL

ﬁEEL - [5CL Source{2) -- book_scl'S7 Programi{1}]

File Edit Insert PLC Debug Yew Options ‘Window  Help

D@ &| o] 2 [E]e| en|es| || o] |

o [#é| o] 25|l

4% 7| %]

- FURCTION FCl: VOID
ENOW_HOW PROTECT SCL 57+
; WRPRRF () = =
END_FURCTION

ki

Eranslate: book_=cl457 Program (1) Sources\3CL Source(2)

lock: FCl
ezult: 0 Errors, 0 Warning(s)

K 4-1: S7T-SCL JEFE)T
4.1.4. [\fR: A AREITIT S7-SCL REMEFFE, BrarERiE STL #R?

W KA AT IT S7T-SCL RANKFEF I, o ioas A a2 STL #% a2

fift %5 : ST-SCL F& ¥4 B i AL AT AR 52 1204 STL #%28, Wi R i) FCL, BARHFR7R A SCL
#al, HA R PR Source H s 1) FCL YR SCAFIMER f, FRHRFTHF FCL &, 2onih STL
S

Object name | Symbalic name | Created in language I
i3 0B1
mH AW
{0 DBA0 SCL ,r R
{FC1 SCL —=——— FC1 )& 1

4-2: HLfY SCL @ik
VERE: PR A P BT H A MBS S7-SCL VEACHDS, i HAEEF] STL A& KRy,
T ARSI ST-SCL )T AE STL A R LT TVET LR BE T v I iR

4.1.5. [H#: 4R OK Flag?

H

o] @ f+2 ¢ OK Flag?

fift%s: #E ST-SCL F2/7H, OK s&— /M /RAEA PR IR AR AR &, & HOR BoREPAT & 75 15
OK FrENIME S STL Zaferh % T FC/FB () ENO 4b¥ (STL 2 HPIRES T BR A RARARIRA)
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Excellence in
Automation & Drives:
Siemens

AR AL AEREP IR, T LK OK AR A A TURE, W SR AR P HAT A8 e (Bl 0 A BRED,
MR RN, R R R OK Arilth’5 ) FALSE, UECELRE bl A-fifi /2 4 tH 240 ENO 4
. OK WM RGALRE, AFEES, WM A R2ER P bsd, AT BL7E S7-SCL
Y >E . Options>Customize>Compiler H1, [ 4i%E$: Set OK flag.fil. 77U ENO oyl VFAl «
OK ¥t 9911
OK:=TRUE;
Division:= 1/ IN;
IFOKTHEN  // BRiZHAEIEH

M BEAE T LS INERRIEBRAE IE AR OL T, JLE A e
ELSE HERIERAEANIE R

Al

END_IF;

4.1.6. [HB: S7-SCL HFZF—PMHLALKER

. 5 STL ha DLBEHC—MNMAZURMME R (Bl OBL hWEIRIN [H]), 7E S7-SCL th2fifr
{E IR AT RE 2
fifp#: STEPT " MER OB HAEA K I, FLHHR HBh A e — LA G N A2 i, filin OB1
[1)7% 5 OB1_PREV_CYCLE Hi2y CPU A% F T I IS i) 7 S7-SCL S A, 18 i Insert
> Block Template > OB” i —4~ OB #5ifi. FEBAEHHL T, AR 115 I AR B DX ok i gt — A
ARRAY OF BYTE SRt AL & . Bh[X 855 OB i ihi iy A2 o DX A I FY L i T A2
AR, IF LB BRI AT, BT AR P A R R AR AT . W SR P AR S7-SCL
%201 OB BN (FRE A AR i, 4% N AP IRIEAT

o {EFK1% STEPT [Hik1%  \Step7\STDATA\S7wiz , & FTH OB Hffy STL k& AR,

A DA S AR T IX LB (41 OB3Ll.awl),  FFAZ AN AR g o

o QUEE—/MFIY ST-SCL W SCAF I AN RIA S A8 e o

o %L ST-SCL Y Ak IiEA S 1

o {EXAFEFIITURI Sy, wILAWE "Title" Al"Version", {4y Title=" ' fil Version="0.1'

e {t BEGIN iEHJGIHAHEAN DT, b, RIsgmis 1Bk,
34k, AT AFTIFASSC R ) S7-SCL 45~ H sk i) OB_Templ JiH , A 4u$E T 44 4> S7-SCL i
SCPERS A AL
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Excellence in
Automation & Drives:
Siemens

4.1.7. 8. WM FC/SFC 2% RET_VAL GRFEME) ?

) R el BRA# FC/ISFC WM i 240 RET_VAL GiR[nlfE) ?

fide: UL, B PASCAL 1 & Bl i g FETE 5 AR #A R, T RE I el gt A 2%
DR, Y% SFC (RZIhAE) A S8 RET_VAL GRIFME) , e Mt— AT Eiph ez
. STEP 7 fEA MW H I 2 X T RAE DMt 240 RET_VAL {5 5. 71 SIMATIC
BT SFC ARJETE “FL7 MR DUSRBURISC7E L Bhfs B .

FIFE, —A FC AT LR A —ANGER, Niligs i 748617, Sl 7 afl{E S7-SCL il Ak
MI{E (RET_VAL) MIIZhiig (FC X SFC).

€ CFCL, RECRA INT - GRIFIED

FUNCTION FCl: INT

VAR INTUT
a: INT:
h: INT-

END VAR

IF a*k THEN FCl:
END_IF;

n
—
o

IF a<b THEN FCl:
END_IE;

1a;

END FUNCTION

Bl 4-3: AR [EME FC 1€ 3
W FCL A3 2R [FIHE

EUNCTION FCz: WOID

ThR

m_;;,;““ FH A LUARYE FC
(103 1] 48 340 bt FC

BEGIN - ((1IEAT 45 5

c:= FCl {a:=1, b:= Z);: \\
END FUNCTION

Kl 4-4: R AT [RE R FC
JHH—A R4 hfE (SFC24): 4 R4 Thhe SFC 24“TEST_DB (M EE YY) 1, #4355 F CPU
FEWNAEF AN EEEE B . SFC24 #fiefaxe DB s 714, kA% DB &R 35 M)
.

¥eE DB TS R 7 HGE i 350 “DB_LENGTH” #iil, 23 “WRITE_PROT” fu &% T
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Excellence in
Automation & Drives:
Siemens

e DB WS ID M5 E (FALSE ¥ ASHRYY).

FUNCTION FClo: WOID |~ ]

TAE INPUT
DE _Mo: WORD:
END VAR

TAE OUTPUT
BetWal: INT:
No_Byte: WOED:

Write_ P: EOOL: l@@{ﬁﬂq?
END VAR
- Pl SFC iz
(s v TR
Z2: INT:
END VAR
Z:= 5FC:z4 (DE_NUMEEER:= DE_HNo
RET_VAL:= BRetVal
LE_LENGTH:= Mo Byte, HNo Byte = 1c#000C
WRITE_PROT:= Write P): Write P = FLLEE

END FUNCTION

Kl 4-5: A A IRFEMER SFC
4.1.8. 8. 7& S7-SCL #EFH, PLC F bk bniRA = IR

. 78 S7-SCL F2/¥H1, PLC Hffitthhibbr iy STLILAD H f L hEbR AT ff (X 53, A FH A ol v
=8 TN

fift%: 78 S7-SCL F2/FH, PLC W ¥l b STLILAD H (AR RIEAAAR], J5 8 T 4afE A
PRI AR S7T-SCL B . N PLC () S7-SCL F2 7 Mk A b =X«

Bl rh— st U 2EE IR, SEBr L, i BORS UAE S7-SCL AR IERI Y o

DBL. DO. 0:=DB1. DBX0. 1;
DB1. DB1:=DB1. DBBI;
DBL. DW2:=DB1. DBW2;
DB1. DD4:=DB1. DBD4;
QX0. 0:=Q0. 0;
IX0. 0:=10. 0;
MXO0. 0:=Mo. 0;
PO, AE— UL, giREA SUKIH AT EL STL kR T5 U T+ S7-SCL,
FERG WA g 5 B kR AR 1 10 ik 5 5, W2 S7-SCL 2 bR U 5, Bl
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Excellence in
Automation & Drives:
Siemens

LUNNEETR
STATUS_1:=WORD_TO_BLOCK (INDEX).DW [COUNTER]; (144 =X, i)

STATUS_1:=WORD_TO_BLOCK (INDEX).DBW [COUNTER]; (4% 204t1%)

Mnemonic addresses Data Type
(internat.)

Qi Cuptut (via the process image) Bit

QBx Cutput (via process image) Byte

QD Cutput {via process image) Double word
QW x Qutput (via process image) Word

QXxy Cutput (via process image) Bit

Dy Data block Bit

DBx Data block Byte

DD Data block Double word
DWx Data block VWord

DXy Data block Bit

Iy Input (via the process image) Bit

IBx Input (via process image) Byte

1D Input {via process image) Double word
IV Input {via process image) Word

12y Input {via process image) Bit

M.y Memory hit Bit

MBx.y Bit memory Byte

MDx Bit memory Double word
MW x Bit memory Word

WX Bit memory Bit

FQBx Qutput (Direct to peripherals) Byte

FQDx Qutput (Direct to peripherals) Double word
PO K Cutput (Direct to peripherals) Word

FlBx Input (Direct from peripherals) Byte

PlDx Input {Direct from peripherals) Douhle word
PIWx Input (Direct from peripherals) Word

K 4-6: S7-SCL Hf#) PLC HuhikA% =X
x WBAR 0 %2 65535 Z A4y (Zaxftbhl)
y AL 0 & 7 Z a7 (Al
$FH ¢ FB,OB,DB, T,C 555 [MAr ik 2\, S7T-SCL A% NI A S STL #% AR IA], b AR AN 6

4.1.9. BE: R AR N TRAREFERIER L E R EERHER?

)R A2 FH N A N R P £ 2 PR I 28 4R s TR IR A R 7
fifp: ST-SCL R APT A Mgl 5 —FF, A A CRrE ik, MRS HWEEN AN T
AR IR B TR 50, PRI e PR k. PRI om A U AR N R AT S7-SCL R 11 52
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Excellence in
Automation & Drives:
Siemens

ESE R Insert 1, #2417 Block Call, Block Template, Control Structure, =A%, H A BLUE L
I, fREmEMAREE. Gl T B de s TN AR, H P R IS, KRS
T

FURCTION Flxxx:
% i o XA 75 147 S 400 T A
YAE_ TENF

Ff Temporary Variables

ERD_VAR

S5 Instruction Section

: 4% END_FUNCTION 5
FCxxx := 100 END FUNCTION BLOCK JEiE, Sasis
END_FURCTION

FOR Control Variable:= 5tart TO End BY Increment DO
Ff Statement Section

END_FOR; A A Sl N .
- P &5 T DO J8s, 3R

ERD_FURCTIIONR

K] 4-7: ST-SCL ‘& WLIF) s A% 4%
4.1.10. [ : G0fIXF S7-SCL P BRI R ST ENIHL?

)8 Gnfe] X S7-SCL FEJPH 1 £k b S i A AR BT iR Ak ?
fift % ST-SCL PR ot H s B M 5 AR B AR A A STL 5 S48 202 AL, NI AR 741 L T IE#fidg

it
DAT1 : REAL :=100.5;
Al:INT:=10;
A2 : STRING[6] := 'FACTOR;
A3 : ARRAYJ1..12] OF REAL := 0.0, 10(100.0), 1.0;

4.1.11. rlj—_]ﬁ.‘ij, 'ﬁ‘/l\;Eé “AT” *E‘A?\, ﬁﬂﬁﬁﬂ%?

). fFase “AT” 454, W ?
fifRe: AT $5452 ST-SCL HHFA I — MR, HIFH T RES RIS ILSR 2, s FL B A B R % o
AT 5415 ST-SCL AT H AR H FE A fr, AR 2 WY FIRE P AR U AR o N IR g 22t
AT PEAR U o

AT $52 AT LI BE % USRI B R AR U ) — A D AR . 2R T i
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Excellence in
Automation & Drives:
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PRFETE T “4hR” M. IR W R A
o REmi—: EMERNAER, EHEASETAHRI
o BRI fEHRAT DU AL e B 28 A A
o RERIT: B HURE A SR R AR T AN R AR, DU R B, S
ERFEAR T
N TR R AR R R L =AM AT BT, 56 L UDT100,UDT200, /MR N 12 AN,

{HZ AR . UDTL00 4045 —4> DATE_AND_TIME #5258 (8 M), ibadf— s (44

FA); UDT200 1045 6 N7 (12 NFEA); 7E FC2 & Xt N2 % Buffer, Framel,Frame2:
B @ U AN, EEOSHPAHI. P ELMASES 3 4, (HIUESRNAE
B, FERE DS EUH L Buffer i NS4

E .__SEL - [FCZ -- book_scl\S7 Programi1}]

File Edit Insert PLC Debug Wiew Options tindow

Dzl & ©] =] enles]snls:]

TYPE UDT100 ‘ .
T K = e HUE AR Framel 4k7& T Buffer [0, SUEHE
WY_DT:DATE_4ND_TINE; ; Y
I REMLRERL: KALEH, YA, JLIEH UDTL00 KRN T
E;‘";ﬁ“““ S TR Buffer /b L 75 U4 PEAS IR
TYPE UDT200
STRUCT N y e "
- _— Y[0..5] OF WORD: R SRR UDT200 K& M /N T25F gk & 1)
Enim;}i;ﬁ“ﬂ Buffer K7y, 57 W2 P4 %

FORCTIONR FCZ: VOID

YAER_ THPUT

Buffer : ARRAY[0..11] OF BYTE ;ﬁ ERE: UDT100,UDT200 4%7% T Buffer 1k
- Framel AT Buffer : UDT100 ;
Frame2 AT Buffer : UDTZ00 ;
ERD_VAR

7t OB1 i H] FC2 34— IR E %

i} File Edit Insert PLC Debug Wiew Options Win | Buffer A S

DEeJd & 4 BR o o 0

HLAD,/STL/FBD - [0B1 -- book_scl',S7 Programi{1)]

Hetwork 2ENeRIRY B BN E DA B0 34, (/e
CALL FC 2 WA, N ZHAH I Buffer Hit N 24k

Buffer:=DEZ. NT_ARRAY EVTE

K 4-8: AT F84F5 A (a)
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SIEMENS

E%'!' SCL - [FC2 -- book_scl%\S7 Program{1}]
File Edit Imsert PLC Debug Yiew Options Wind

D3| & o] % [5[@] enles|dl

FORCTITON FCZ: WOID

YAR_THPUT
Buffer : ARRAY[0..11] OF BYTE;
Framel AT Buffer : UDT100 ;
Frame2 AT Buffer : UDTZ200 ;
ERD_VAR
YAR TENP

TEST_DT:DATE_AND_TIMNE;

TEST_REAL:REAL :
TEST_WORD: WORD ;
ERD_VAR

TEST _DT:=Framel.MY _DT;
TEST_REAL:=Framel.Mi_EEAL;
TEST_WORD:=FrameZ. MY_ARRAYT WORD[0O];

FEA T ST\ S5 Buffer 733 1 5dE, mrLL
¥ Framel,2% Frame2 (4% 203k k. 0 4nay LA
F-T) = BN S

DATA_AND_TIME, % £ Ifii48 & TEST_DT

¥  Buffer 8

END_FUNCTIOR|

K 4-9: AT $52%5 K] (b)
AT $RANET 1. 42 STL H, JH7 A A BIAT MBO (2 — A BB AR A S 1, 140 3R 3
fir, BE#ETHEMO0.2 FEFTLLT o ifE S7-SCL 1, i T H AR RE S R sl T RAE R AR )
gk — oA BINH) . BRIAE STL thRj s #AE, 75 S7-SCL h IS %k K . H Ll ad ff 1)
AT FRA BRI goX AN 8 BRI 7o, 23 AR 75, T AR O 57151 8 Mz
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FUNCTION BLOCE fhlZ3
VAR INPUT
MainWarByte: EBEYTE;
FilterWVar AT MainVarBvyte: ARRAY[O. . 7] OF BOOL;

END_VAR
VAR OUTPUT
X0: BOOL; ESURINSEL, ] AT $54, B A gk & 3 LA
¥1: BOOL;
¥z: BOOL; BOOL ##i AU 2 p i £ 4l v
¥3: BOOL;
¥4: BOOL;
¥E: BOOL;
¥&: BOOL;
®7: BOOL;
END_ VAR JE i 24
¥0:= FilterWar[0O];
¥l:= FilterWarll]:
Wg:= FilterWVarl:z];
H3:= FilterWVar[3];
Hd4:= FilterWar[4]; NI
¥E:= FilterVar[E]: U\ BOOL ﬁiﬁiﬁﬂj
¥e:= FilterWVarlc&];
H7:= FilterWVar[7];

END_FUHNCTION BLOCK

K 4-10: AT $54 1 (a)
AT $82 N BT 2. {E S7-SCL 1, ANY BRI H], LW St AT S0, i
RT3 T TR 20 oS ANY B 8B P i N 2. REIF T 45 R0 2 T
CALL "BLKMOV"
SRCBLK :=P#DB1.DBX 0.0 BYTE 10
RET_VAL:=MWO0

DSTBLK :=P#DB1.DBX 0.0 BYTE 10
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SIEMENS

E%'l' SCL - [FC3 -- book_scl"S7 Programi1}]
File Edit Insert PLC Debug Miew Options ‘Window Help

DBl 3 =l 552 enles|dalss| | 1< [T &

FONCTION FCi: VOID
YAR TENFP
TEST1:STRUCT
SyntaxID: BYTE;
DataTvpe: BYTE;
DataCount: WORD; &5 HE 2% STEPT KT
DE_Number: WORD;
Bvte Pointer: DWORD, ANY Zie S A
ERD_STRUOCT ;
TEST2: STRUCT
SymtaxID: BYTE;
DataTvpe: BYTE;
DataCount: WORD;
DE_Number: WOED:
Bvte_Pointer: DWOED;
ERD_STRUCT;
Data Source AT TEST1: ANT,
Data Destination AT TESTZ: ANT;

FESULT: INT;
END_VAR -
It T
TEST1. SyntaxID:=16%10; PATER:
peol e paralyper o Data_Source =P#DB1.DBX0.0 BYTE 10
TESTL. DataCount :=16#0L; =

TEST1.DE_MNumber:=16#1; :;;;Ef:_,,———”'

TEST1. Byte_Pointer:=DW# 16854000000,

- TESTZ. SyntaxIDi= 16210 -
TEST2. DataType:=1642: PATER

TESTZ. DataCount :=16#0L4; Lo
TESTZ. DB_Number:=16%1 Data_Destination=P#DB1.DBX0.0 BYTE 10

TESTZ2. Byte Pointer:=DW#1a#E4000000 ;
FESULT:=BLKHGH(SREBLK := Data_Source, DSTELE :=Data Destination) ;
END_FURCTION

Kl 4-11: AT 584 W H (b)
AT JRAEMA LT, EFWTEREN.
o AT H54 HI TR A AR o BEAT FCe B S I 75 W I, 00 RO AP AR s 1) 75 W o ) i T
o AT R4 HHIAR B A IR
o AT IR TR A A B BRI, o5 AR/ NN T4 T I A s K
o AT RA M TR AR B e MR BT A WIS, R (245 2 e Ve
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i) SIEMENS

At HyE R Y
NSk CTE
Elementary Complex ANY/POINTER
FB LBzt Elementary X X
VAR, VAR TEMP, Complex X X x(1)
VAR_IN, VAR _OUT ANY/POINTER x (1)
FEHR Y Elementary X
VAR _IN OUT Complex X
ANY/POINTER
FC LBzt Elementary X X
VAR, VAR TEMP Complex X X X
ANY/POINTER X
el Eayit] Elementary X
VAR _IN, VAR _OUT, Complex X
VAR _IN_OUT ANY/POINTER

Bl 4-12: AT 525 H BR
(1) AT 84 H T ANY KHTE VAR_OUT HUEA SLVFI)
Elementary (JEA<%#525/M413%) : BOOL, BYTE, WORD, DWORD, INT, DINT, DATE, TIME,
S5TIME, CHAR

Complex (H Z«%#lE K40 45) : ARRAY, STRUCT, DATE_AND_TIME, STRING

4.1.12. WfE. S7-SCL B uffFHELEETR?

). S7-SCL R i i ] 2 = 5t ?
fift%s: ST-SCL B/l MEH Z B 5t, FHIMBPAIH T IEM& X, HIsemn, o/ b
CINGDEE

Supplyl : FB10; 1% Supplyl 5 X4 FB10 87

Supply2,Supply3,Supply4 : FB100; 1% Supply2,Supply3,Supply4 € X4 FB100 274
4.1.13. [A)fE: WHTLE S7-SCL & e B B ik [a] 482 54k 2

. T A5 ST-SCL T v S I At B[4 51k 2
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SIEMENS

fift . ST-SCL Refyrh ot Bl B (1 T IE3R A1 17 R AFI S, SR AR . R I8 1 1E

A% X

STATUS_1:= DB11. DW[COUNTER] ; /A TR

STATUS_2:= DB12. DX[WNO, BITNOJ; // TR0k, F P B8 WNO, BITNO 2 ff HY my
STATUS_1:= Databasel. DW[COUNTER]; // Databasel & DB JSAY[¥) A

STATUS 2:= Database2.DX[WNO, BITNO];

STATUS 1:

WORD_TO_BLOCK_DB (INDEX) . DW[COUNTER] ;

//INDEX #%& Xk BLOCK_DB (#1257, COUNTER b3l Ry, xXAEn] LUSEHl/ $i s 5,
o bk R A S, T AR — R REAR sk A4 Sk Uy 2K

//UAF R B B T 0T U, U

STATUSBYTE :=DB101.DB10: [/ H T
STATUS 3 :=DB30.D1. 1; /) B S HE
MEASVAL :=DB25. DW20; /) FH BT HEg

STATUSBYTE :=Status_data.DB10;
STATUS 3 :="New data”.Dl.1;
MEASVAL :=Measdata.DW20;

STATUS_1 :=WORD_TO BLOCK DB (INDEX).DW10;

4.1.14. . 7E S7-SCL i FC/IFB 57 STL/ILAD FH X H?

)@ {r S7-SCL #Efrifi [l FC/FB 541 STL/LAD i 1] FB/FC £ i [X i ?

fif#%s: £ STL/LAD #2/7 il FB W] IANESHUAE 58, {HAE S7-SCL F/yH M FB I, 220
8 FB ZHUH S 5¢ 4 %1 FC i ] S7-SCL 5 STL/LAD X AN K o 5 U U4 FE A B2 4] S7-SCL
AR m) T FB. T R U B T R 7 0 DX 1)«

SCL 1, FB [N/ S H WA s 5¢

76 STL 1, FB [ F A% X $&, i L AN S BORE RS 3 S 5 S

BORAG ¥ AN, FB R kg 2 45 22 5|
AL

CALL FE \/10 , DE10 FE10.DE11 (MY IN 1 :=FALSE I

o L % SR

MY _IN 2 := y -

NY_0OUT_1:= MO.0:= DE11. MY _QUT 1.

WY_OUT_2:= MO.1:= DE11.MY_OUT_2; ot gy HH A

4-13: STL/S7-SCL i H] FB [X %I
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4.1.15. [ FEEE] “REAL” Bm KR 7 BAL AR A e KR e 7 ?

. A T S7-SCL P RIA HdE 2K AL(BYTE, WORD BY, DWORD)##t5 “REAL” #5574 I},
s LA WIR o Kt R T A e e 2

fif%s: N T ST-SCL i Eidi 2 M (BYTE, WORD 1Y, DWORD)#% #8157 ¥ ¥ 2% “REAL”
I, w5 EHI LA N 4R

e M BYTE %] REAL: “DINT_TO_REAL(DWORD_TO_DINT(BYTE_TO_DWORD(value))”

e M WORD #I| REAL:
“DINT_TO_REAL(DWORD_TO_DINT(WORD_TO_DWORD(value))”

e )\ DWORD #| REAL:
“DINT_TO_REAL(DWORD_TO_DINT(value))”

HEFI: P e BYTE, WORD & DWORD #2435 “REAL” #4288}, S7-SCL
HR DL R T LA S 4

M WORD #|| REAL: “DWORD_TO_REAL(WORD_TO_DWORD(value))” (#5i#=FEF).

WERPAT TIX—F 4, SARERT45
JRIA: DINT_TO_REAL pRECHICYR B #3144 IEEE - REAL MM/ 2 H A8 &, M
DWORD_TO_REAL XA I+ VUL 42 H B2 .

Lk, 8 T3R1FIEM R “REAL” %, 405 218 i o [A] 22 2% “ DWORD_TO_DINT ” Al

“DINT_TO_REAL” 28,

4.1.16. MR : 7E S7-SCL HFUIfX 3B EHZEAMDE, BEEFFSH?
W AE ST-SCL Hran el X 43 HeAAS 22 R A M AR &, I 254472
fifg: ST-SCL AR MAR 2 5575 2 15| HA W~ X
o MAGIHPHAZRRES, WHASE N AARF, W: Motor_Status:= Motor 1
o WRGIHPZELIH LAKE <7, WL ENFFSH, W: Motor Status:= “Motor_ 17
4.1.17. AR QAT [l — AN FART R AN AT

R SO A e A 2
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s W T R I RASTAE, AR R RV R, AR
MB10 : = strl5] XPFAUFRIAARIILLIURE 72 B 5 5 AT AHE S MB10 .
Jitk: ATUMEM TEC PR3 MID SRAGE|FATH BREAN 2, Bl 5k

VAR

str : STRING[20];

END_VAR

MB10:=CHAR _TO_BYTE (STRING_TO_CHAR (MID (IN:=str, L:=1,P:=5)));

4.2. BERFAAER A

4.2.1. A Wil AE VT A &5 M BT AR AL IZ 4T I ) ?

(s WAL AE Vg ) G A I LS A T I 1] 2

fif s WRFTEZL ] — NG5k, AITE S7-SCL ARHE bt G 1 — A [FIRE 2R A () e A2 e kel 12
AT TE] . 0P AT AR I N A A W R AR AR R, IR R 2 T E . B A e i R
(e

DB4.Field.Value:= DB4.Field.Value1*DB4.Field.Value2*DB4.Field. Value3;

LA EBRAERCEAE AR T DB IS M 2, FEAHT UL RIS DL R, X BORE P AR TN, R 22 T
TP, AT 2 IR ESIURAE, RFIsIT TR AR 2 .

EﬁEEL - [DB4_FC4 -- book_scl’S57 Programi 1
File Edit Insert PLC Debug Wiew Optior

D8] & «|=| &= e

DATA BLOCE DE4

STRUCT 5E X DB4 [ 45 14
field: STRUCT
value:EEAL

waluel :REEAL;

wvalueZ :REAL ;

walued:REAL;
ERD_STRUCT;

ol ERD_STRUOCT; N
BEGTN Yintt DB4
field. walue:=0. 0;

field. wvaluel:=0.0;

field. valueZ:=0.0;

field. valued:=0.0;
ERD_DATA EBLOCE

K 4-14: & XEHEE
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IRk AR FC4 h A ] —/> 55 DB4 th “field” Ae 45 FAH [m] (I I A2 & (141 “Temp” ) o RJG
A B TEF A DBA HHCRE Bcdla % DL I I A7 i XA -

e Temp:= DB4. field;
XFUL_E iR r)iER), Rk DB 4B e “DB4. Field” BANIGH 2L & “Temp” :

e DB4.field.Value:= Temp. Valuel*Temp. Value2*Temp. Value3;

SR Ho st A BB AR S R CPU R L ERS T, AEJSBeRe e bl LU I L8 L HERR P i i i
A P AR B S AR B, T CPU X L HERR (R 17 38 28 R0 B DR g U5 [ R, X
FUSEOL T Bl Vs ] A AE

EﬁSEL - [DB4_FC4 -- book_sclyST Programi1]]

Fil= Edit Imsert PLC Debug Wiew Options ‘Window Help

0|2 ] S| oo 2@ enles|dalds| | <]

FORCTION FCd: VOID
YAR_ TENFP
Temp: STROCT
walue:EEAL ;
waluel :REEAL ;
wvalueZ :REEAL ;
walued:REAL;
ERD_STRUOCT;
END_VAR
Temp:=DE4. field;
DE4. field. walue:=Temp. waluel +Temp. vralue+Temp. waluel;
ERD_FURCTION

Bl 4-15: DLtk Aes B il

ERFEH: RS “VAR TEMP” {747E CPU [HEAk . X W] S 7E /M CPU EHuh S EOf M
o DR A P I I A e R L

4.2.2. B el AR R BV BNAL |F B A) R 48 MR PR [H] ?

e ey A R B AR B A |F S5 f SR LA FA I R] 2
il FEUUAE IR )G, ST-SCL ARG AZAG B B8, XA P S R AL BRI PR R PP T S
ARG, LA e AL HeSs — A ARXE TR 3, IR T8 58 48 s R I 75

BN — AP & (TRUE 2¢ FALSE) .
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ZNJNE

AL L (REAL 22 )i 2 (AL 2 100) I 5 B — AN s A7

PR “IF_Test” (L7 T AHIBUE (A0 IF V0. 6 IF T-A0l 1 BL R i A0 RE
IF_Test:= (100 < value) »

FUNCTION IF_Test - EOOL

VAR INTUT
walue - BREAL;

END_YAR IF 354 1) 53 20
BEGIN

F 100 <= walue THEN
IF_Test 1= true;
L5E
IF Test := false;
WD TF:

END FUNCTION

FUNCTION IF_Test - EOOL

VAR INTUT
walue: BELL; . e b
END_VAR IF 5 ) (1) 5534 X

BEGIN —

IIF Test:= (100 < walue) ;|
END_FUNCTION

4-16: IF iBEA)ANHEHE A (a)

~2:
EEVHAE—> WORD A% i g 50 LU X S 15 B A .

IXHLPREL BitX [ IF iEA) i DL R iEfA)fC#: BitX:= status = 16#0004.
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FURCTION EitX: EOOL

TAR_IKPUT

stariis: TWORD;
END VAR

BT
IF =status = 1680004 THEN P

Bit¥:= trua;
ELSE

Bit¥:= false;

END IF;
END_FUNCTION

FUNCTION EitX: BOOL
VAR INFUT
status: WORD:

END_VAR IF 15 1) S A 2

BEGIH —
[Bitk:= status = Llego004; |
END_FUNCTION

4-17: IF iBA)ANHEHE 2K (b)
WRE: KB IF EA e TR A BENE, (HOS P ab BE AT G815 R 3 AR A3 AN 08 17 b Rl v+
PRI

4.3. GrFEERIRAE R A

4.3.1. \@: S7-SCL BFEMNNBFITHEN _ EITATTE SR 1% ?

s R AT 2B ST-SCL F2/F 48 H RSN Fgn 315, 7R AN 3T A TR BOE A
P2

s I AN TN L 7 2238 T S7-SCL MK, iy HL G 7% S7-SCL M BghicAS, 4. S7-SCL
V5.3 SP1 424t 7 Hr it sk % (SEL,MAX,MIN,LIMIT,MUX,BYTE_TO_INT,INT_TO _BYTE %:4%), |H
FRATCE AR X G bR A W S P R P Tk Sk R, R IR AR 1 S7-SCL FRdss I vk ok 4

.

432, H@: A ABRKEFSHNANEFRTEE 2, NEALHIE?

s A ARMFEF SRR e 480 AEAE 42

fies . B 7RI U A R AL, SRR H A RIS N R, X AN
o HPHEGS ST-SCL R PSS, XA 5 34T RLAF (R S0, T AL REI T 2 M 142
22 AU A N A, AL RIS R, DA THE S7-SCL ey P4y i BLANT 2 (1144
FR3E S NI B0 PR IR
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4.3.3. 8. 4 A S WORD/DWORD HIZAS &1 IF EAIABEB g Rt 2

W A A LR ST S WORD/DWORD [HAS &1 IF 1EA)ANBER: g it 2

%5 : MAE IF 54 W HLEERERU, Wi AR g~ 5 WORD A1 DWORD 287, S7-SCL X ARiFkb
BEAE <=7 F O, A RVFICEHRAE “>7 R “<” o AE—Fhah R, @A m s
HH% DINT. i SRAS B RN RE R I Sk DINT, {EMELLE: 2 BTS00 o 5e AT SR I S

4.3.4. B HBE—DNFREZEN T —DERBERN, HIAEEIRERHIR

iR M — MRUERBR R T — AN AMER, I Invalid data type &, 1T
P AT B3 B o RS BE 254 BOOL, BYTE, WORD 1 DWORD Hf, FuiZFtf DB B (¥t
Hhks )

I T2 A5 330 B ] 5 5 1 A 2 4k

FUNCTION FC7: INT

TAE TEMP
i: dimt
h: real;
x: dword;
END VAR

M.

oz

hi: LEo_0o;

FSAfConwersion from Peal o DTWORD.
DE1.DD[0]:= real to_dwaordih):

ot walid data type, mast be conwerted.
A DEL.DD(4):= ki

DE1 . DD[4]:-= =x:
JSithis is correct, because x i=s a DWORD.

Finr= he
ot walid data type, mast be conwerted.

x:= REAL TO_DIORD (k) ;
FSAfConwversion from Peal o DTWORD.

FC7?:= 100;
END FUNCTION

K 4-18: Hda S AL
4.3.5. [ FERIHE O RS RE R SRFITRE A

] R A R R B S R AT B AT
fif: 2 ST-SCL BE/PATHUE L 65535,  ST-SCL 4miaedlAT V- A#s ToBi A 1 FFan 4. i, 7
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ST-SCL EREFh, —ANgmfaiiz h LA S 65537 17, LU RATECT- ¥ pldan it :

“F: L 00001 error xyz” , A “F: L 65537 error xyz”

fiF R vk Wk ST-SCL Swideasiin o I A RS, JehB Bk EA EFIIAT . W R gn e R A
TEFTHE R IMAT, FR0T DU FHSE R A4 Edit > Go To > Line... #RJGHIN" 65536 + fWomisinsk

TR A R AE R AT
4.3.6. [AJf: "The FB is not available or the instance declaration is missing"

) @: “The FB is not available or the instance declaration is missing”

R BRI S BLAE 2 —A> FC/FB/SFB/SFC HRAEREFFHHaM IS, AR IRAA TS AL R T
fil Rk 1 F-BN R HIAH DGR P PR3] BLOCK SCAF K H 4R J5 5B 4 v S7-SCL.

fil v J79% 2: H FC/FB/SFB/SFC i, f#H S7T-SCL 2 Hiff) Insert>Block Call [, S7-SCL ¥

23 ¥ FC/FB/SFB/SFC &2l 31 X4 i (1) BLOCK H s, AT ik 4 A A5 5L Hi
4.3.7. . "Character strings have different lengths"

m]#l: “Character strings have different lengths”

fifs: Bl Fy FCL A FC2 AP A AF A8 it "name 17 15" name 27, 4 FC1 g4 i, 155855
“Character strings have different lengths”. fFizATHAE], ZEMEK A M ("name 17) V] HE 2
—ANEEZE M BT SRR STRING A2 (“name_27) BAT S KA 1) STRING F4F .

R PIT I BATEBCT oM )AL & "name 27 AW —ANMKE A 254 (1) STRING 47 o T SR i

PERA R A MR FC2, RIS AL H L,

FUNCTION fcl: WOID
VAR INPUT
name_ l: STRING[10]:
END_VAR
YAE._TEMPF
name Z: STRING[LO]:
END VAR
BEGIN
name £:= name 1;
END FUNCTION

EUNCTION fcz: WOID

VAE_INPUT

name_ 1: ETRING[10]:
END VAR
VAR _TEMPF

g
END VAR
BEGIN
name 2:= hame 1;

END_FUNCTION
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4-19: FRrEE X
TR WURAR KA 254 P45 STRING P47 8, W43 T5 52 01 K (R A Hb BE 2 A7 i 45 1)

4.3.8. [M@: CPUHE"STOP due to unknown OP code"

M. CPU V4 JE.”STOP due to unknown OP code”

iR . M4RAE ST-SCL rh i %40 T "WORD _TO BLOCK DB(...)”, I H4w# L FiBf) iz B4
PR

Display: = WORD TO INT (BYTE TO WORD (WORD TO BLOCK DB (DBNo).DB [DBIndex])):

fif Tk AT AL N 45 AT v AR AR i i ) -

tmp := WORD_TO BLOCK DB (DBNo).DB[DBIndex]

Display := WORD TO INT (BYTE TO WORD (tmp)):
4.3.9. WM. 7E47F UDT K31 Syntax error with UNLINKED"

). E4wi% UDT I HHEL”Syntax error with UNLINKED”
fif s WA —> UDT 7 FH”UNLINKED” /5 B Z H b i, 1% UDT AZslidmiidid . “UNLINKED” &t
IZAEAR Y - STL Y4
FEJF W], UDT W H S S ST CPU H, I RAAAE T 37 10 ST - P RE )7
FHORAR: T "UNLINKED B B g 1, EWkAE DB HAy LU R AReE:
o UL TR it
o AEHEAEAT RAM A [H] o
e “UNLINKED” Jai 4 75 W 75 £ B 14 3k 350
o SREFPRAKIEKR

ANFTHH T UDT. gmidefi<s LLES 29 5" Syntax error with UNLINKED” 45 .
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DATA_BLOCKE DBZ1
wersion: 1.0

UNLINEED //only for data blocks

F/Data blocks with the UNLINEED property are only
ffstored in the load mewory. They take up no space
ffin the working mewmory AND are NOT linked TO the PROGRAM.

STRUCT
Test: INT;
END_STRUCT

BEGTN

END_DATR_BLOCK

K] 4-20: Fdl ) UNLINKIF J& %
4.3.10. . 7E4wi% DB B Syntax error with 2#1100_1100"

i @: 7E4 P DB I 1B Syntax error with 2#1100 1100”

i A RARI A BT AR (A — N B BYTE BA M AR &, ik ST-SCL JifE
FEIREs AR 9 B Syntax error with 2#...7

flfm:  Varl: BYTE:= b#2#1100_1100;

E ST-SCL, H#adh el AWL Gl AR e U SRARTE Bt B 4 50 43 IR 5 73 /) IN A AR L AR 1,
WAUEH AWL L A5 o BRULAE R 1 BYTE SRIU R AR i, AN SR VFFR € /N BERIE AR AW UARTE .
ST-SCL £ ({540 B#2#1100_1100) H ] FIFEARRSIX, [AIDh S7T-SCL 4 17w S AEARRS X A AL o

fil ik A T BERIEC T SO TN BER TR ARG

filtu:  Varl: BYTE: = b#l6#cc;

4.4. 5FEREEAAR R

4.4.1. WE: AT 2RNEFPRIFEET, EIEEST?

WL At SRR R, (RS2
fifgy: AEH] S7-SCLBF I, G CPU KA J Al CPU314. RMEUILL, JH /R iE
ERGURRIBR S 0. 25 SO A SRk, AZEFTH] CPU RS i) A b B K
ANEIRR . I RE S BRI CikIEAT .

4.4.2. BB A ARKERLERGE?

G SE a3 A1 Y SR O e R
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iR A TR AT LA I, #E4m ¢ S7-SCL R, 7EZ % Options>Customize>Compiler 1,
W 24i%$¢ Create debug info M. {17 : Create object code Jiith N 2w e+8, 5 MR RS 126 A AL
VRSB A, AR AT HUATFLR . Optimize object code Tt N 4uliik$e, LTSI IE
(AR

4.4.3. W8 fE S7-SCL FFLEA B7E M I TTIEAE B ?
i AT ST-SCL WAL AT b I TGl s ?

. AEMAEIS, W R AR R R R

o RARBIERMAY R, HAZ AR R T R B A R SR AT DA s (- ]
A7)

e DATE_AND_TIME.STRING. BLOCK_FB.BLOCK_FC.BLOCK_DB.BLOCK_SDB.TIMER.
COUNTER A#{ iR

o DI S i) B A s, fdn: “myDB”. DWO, “myDB” A HEANEURE PS4

R AN ARSI T CPU RE SR AL BE AR, Rt LA ik s s Ol

5. Mz —#HEEMUE

5.1. \I'F B3 5™ KR LTRSS
T CRED A7BRA A HEb L SRR % s 5 Sk

W T . http://www.ad.siemens.com.cn/Service/

LR HELERS HSCRY:  http://www.ad.siemens.com.cn/Service/recommend.asp

ASH ] a] 55 :  http://support.automation.siemens.com/CN/view/zh/10805055/133000

ASHH{Z & http://support.automation.siemens.com/CN/view/zh/10805055/133400

“PeZZ” ASHRIX : http://www.ad.siemens.com.cn/service/answer/category.asp?cid=1027
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